
 

Team TimeSheet for Outlook & SharePoint 

Help Manual for Client Users  

   

 

 

  



 

 

P
ag

e1
 

 

Content 

1. Introduction 

2. Requirements 

3. Installation 

4. Setting Connection to the Project Data Source (SharePoint) 

5. Configuring Projects and Activities list 

6. Configuring Local Settings  

7. Configuring timesheet publishing and reporting Options 

8. Preparing timesheets with Outlook appointments or task  

8.1 Tagging Outlook items with project data 

8.2 Group Tagging - Setting project data to multiple appointments/tasks 

8.3 Tagging recurring appointments with project data 

8.4 Reporting and publishing timesheets to SharePoint 

8.5 Updating and withdrawing reported timesheets 

9. Group Publish – Publish multiple items to SharePoint 

10. Review Published – Review Appointment/Task items that were published 

11. How to use Outlook Views to organize, group appointments/tasks 

12. Search published timesheets in SharePoint 

13. My TimeSheet Summary Reports 

14. My TimeSheet OLAP Statistics and Reporting 

14.1 The User Interface 

14.2 The OLAP Grid 

14.3 The OLAP Chart 

14.4 Exporting and Printing reports 

15. Un-installation 

16. Important Links  



 

 

P
ag

e2
 

1. Introduction 
 

Team TimeSheet for Outlook & SharePoint is a reporting solution for a team of any size to work, plan and execute project 

related activities and timesheets in Microsoft Outlook and publish to company’s SharePoint. It leverages the familiar Outlook 

calendar and task interface to track time and expenses towards projects, clients or any entity your business requires. And let 

you measure attendance, payroll, cost estimation or billing for accounting purposes. 

 
 

The client portion of Team TimeSheet provides an add-in interface in Microsoft Outlook to allow individual team members to 

prepare their timesheets in Outlook appointment or task items, and then publish to SharePoint repository. Published timesheet 

includes most of the important predefined Outlook, Project and other custom fields (as deployed by your administrator.  
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2. Requirements 
 

Team TimeSheet is available right inside your Outlook unlike any other standalone application and web based project and time 

reporting software. It can be easily deployed through an installer (manually or via a group policy object with MSI) across the 

entire organization. Please make sure that your system meets the following requirements before installing Team TimeSheet for 

Outlook & SharePoint: 

  

Windows Version  Windows Vista, 7, 8, 8.1, 10. Both 32-bit and 64-bit OS are supported.  
  

Outlook Version  Outlook 2019, 2016, 2013, 2010, Outlook 2007. Team TimeSheet operates directly inside 
the Microsoft Outlook application (using Microsoft's "COM add-in" technology). Outlook 
Express is not supported.   
  

 

.  
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3. Installation 
 

Team TimeSheet Client add-in install is meant for normal users who would be preparing timesheets in Outlook before reporting 

and submitting to SharePoint. Before you install the Client tool, make sure your administrator has already configured the Project 

Data Source settings in SharePoint with the Team TimeSheet Manager tool. And collect the Project database information from 

your admin as you will need to feed to the Team TimeSheet Client Add-in once it is installed (for the purpose of linking up the 

Client tool with the project data source). 

 The Team TimeSheet Client setup is of two different types - one each for 32-bit Outlook and 64-bit Outlook: 

For 'Per User Installation' (ideal for standalone single user/workstation) 

TeamTimeSheetClientSPSetup_x86.exe (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019) 

TeamTimeSheetClientSPSetup_x64.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

For 'Per Machine Installation' (ideal for installing on Citrix and Terminal Servers) 

TeamTimeSheetClientSPSetup_x86_Citrix.exe (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019) 

TeamTimeSheetClientSPSetup_x64_Citrix.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

The Client installation has to be performed by each member of the team before they can start reporting timesheets and other 

project deliverables from Outlook to SharePoint. 

(Note: If the administrator/manager needs to prepare timesheets and publish to SharePoint from Outlook, the Client tool also 

needs to be installed, apart from the admin portion. It is perfectly normal to have both Admin and Client add-ins installed on the 

same machine. However, for normal users, just the Client add-in is enough).  
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Step by Step Install Guide  

 

Step 1. Run TeamTimeSheetClientSPSetup_xXX.exe to start the installation. Click ‘Next’ to Continue. If Outlook 2007 or later is 

not installed, the setup wizard will not be able to proceed. 

 

Step 2. Select the appropriate destination folder where the application files will be installed. If you change the default folder 

path, please make sure you have appropriate permission. (Note: by default, it will be installed under your application data 

folder)  
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Step 3. It may take a few minutes to complete the whole copying and registration process. 

 

Step 4. Click 'Finish' to end the installation wizard. Now start Microsoft Outlook. 
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4. Setting connection to the Project Data Source (SharePoint) 

 
Once you have just installed the Team TimeSheet client add-in tool, you will 
get to see this ‘My Project Data Source’ panel when you start Outlook.  
 
You can also get to this from Outlook > Any Calendar folder > Team 
TimeSheet toolbar > My Settings > My Project Data Source button. 
 
 
So, what is the Project Data Source? 
 
The project data source is nothing but a simple SharePoint list (with the 
name ‘TeamTimeSheetSettings’) that your administrator had created and 
configured under your company’s SharePoint site with the Team TimeSheet 
Manager tool. This list stores the projects and activities, email templates, 
notification and reporting settings. In short, these are global settings that 
streamline the behavior on how all members work, track and publish their 
timesheets in Outlook.  

 
Click 'Browse...' to specify the SharePoint site where the 'TeamTimeSheetSettings' list is located. 
 

 
 
Enter the SharePoint URL site to show all available sub-sites and lists. If your administrator had already configured the Project 
Data Source with the Team TimeSheet Manager tool earlier, there would be a list 'TeamTimeSheetSettings' that stores the 
project metadata and other configurations including destination timesheet SharePoint lists and their corresponding mapping 
settings. Select that list to maintain a permanent link between the Team TimeSheet Client add-in and the SharePoint Project 
data source on your system. 

 
 
In the screenshot above, the root ‘Team Site’ has the ‘TeamTimeSheetSettings’ list, and that is what you need to select to 
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continue. If this list is not available in the root or sub-sites, then contact your administrator for the correct SharePoint site URL. 
 

 

Now, click the Save button, to confirm the connection. Team TimeSheet Client add-in is now ready to connect to the Project 
Data Source to synchronize projects and other settings metadata from SharePoint to your system 

 
Login prompt dialog to SharePoint site - If the chosen SharePoint site uses the NTLM or windows authentication, the add-in will 
use the default credential to connect to the SharePoint. However, for form based or claimed based authentication (for example, 
Office 365 SharePoint online), it may prompt you to enter your credential. 
 

 

Check ‘Remember’ so that the add-in 
can use the same credential to logon to 
the SharePoint site in subsequent 
connection.  

 
You can also specify the authentication 
mode that is used by your SharePoint to 
allow connection to it. For instance, if 
your SharePoint is configured for 
Windows authentication, choose 
‘NTLM’. If your SharePoint site is 
secured with ADFS, you can also specify 
the STS site URL under the ADFS server 
to get the authorization token. 

 
If the site uses a form based 
authentication, then choose ‘Forms’ 
whereas if it uses a claimed based 
authentication (for Office 365 
SharePoint Online), choose ‘Office 365’. 

 

And when you and other users with the Team TimeSheet Client add-in starts Outlook, the add-in would automatically connect to 

the admin specified SharePoint site and would retrieve the project logic and settings data to the local system.  

What SharePoint permissions are required for users? 
Your permission to the SharePoint site - Make sure that you have at least ‘Contribute’ (or ‘Full Control’) permission over the 
SharePoint list ‘TeamTimeSheetSettings’ as well as to all other SharePoint lists that are chosen as the timesheet repositories. 
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5. Configuring Projects and Activities List 
Team TimeSheet Client > My Projects/Activities List 

Before you can start tagging Outlook items such as task or appointment with project metadata and prepare timesheet, you need 

to choose your own relevant list of projects, activities and other custom fields from the project database.   

You do that from Outlook > Calendar > 
Team TimeSheet toolbar > My Settings 
menu > My Projects/Activities 
 

 
 

Below is the Projects/Activities list that are deployed by your administrator (through the Team TimeSheet manager add-in tool). 

Depending on the administrator’s choice, you may or may not choose your own projects and their activities. 
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Available Projects List – All the available projects are listed in this list box. Selecting a particular project shows all 
the activities defined for that project on the right box (in point. 2).  
 
This is how the projects would appear in a drop-down list in your Outlook calendar and task timesheet form. 

 
 
  

 

Activities list for the selected project – This list all the available activities for the selected project.  
If your administrator had enabled 'Allow members to choose their own projects and activities in their Outlook' in 
Team TimeSheet Manager > Form Option, you would be able to select your own set of activities for that particular 
project so that you can only work with those in Outlook. Otherwise, the activities list will not be selectable, and all 
activities for that particular project will be automatically made available in Outlook. 
 

 
 

 

Project Summary – This portion shows the detail information on the selected project, such as, who the manager is, 
when is the start and finish date, what the rate is and the unique color code assigned by the 
administrator/supervisor. The short description of the project is shown at the bottom and the project code is also 
shown in bracket. 
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Activity Summary – This portion shows the detail information on the selected activity, such as, who the coordinator 
is, what the rate is and the due date, if specified. 
 

 
 
 

 

New Project or Activity – If your 
administrator had allowed members with 
administrative access to add new projects and 
activities (under Team TimeSheet Manager > 
Access Control), you would see the button 
‘New…’ just below the window panel.   

 
When you click it, a popup window 
allows you to enter the detail of the 
activity that you want to add. By 
default, you will be assigned as the 
‘Coordinator’ of this activity to be 
added. Note that, this new activity 
would be added to the activities list 
in the global settings (under the 
project database). 
 

 
 

 

 

Specify my own Rate – Your administrator can enable each team member to set their own rate from Team 
TimeSheet Manager > Advanced Options > Total Cost tab.  
 

 
 
If such option is enabled (by the administrator), you would see the ‘My Rate…’ button at the bottom of the window 
panel. Once you input your own rate, it would be updated in the members list under the global settings (under the 
project database). 
 



 

 

P
ag

e1
2
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6. Configuring Local Settings  
Team TimeSheet Client > My Local Settings 

Each member can customize how Team TimeSheet is used with Outlook in ways that the member finds useful and informative 

when working with their projects.   

 

 

Allow automatic synchronization of settings from the database at startup 
When this is enabled, at every Outlook startup, Team TimeSheet client add-in will try to establish connection to the 
global settings list that was configured by your administrator in the Project database. And it would synchronize all 
the projects, activities, custom fields and other global settings (as defined by your administrator) with the local 
cache. This is helpful to automatically retrieve any new projects/activities or settings that were added by the 
administrator in due course. If you are working in offline mode (i.e., disconnected from the network), 
synchronization is bypassed. 
 

 

Add Project Color Codes to Outlook Master Category List 
From Team TimeSheet Manager tool, each project can be assigned a unique color code from the supported 25 colors 
in Outlook. If you enable this option, all the projects with color codes will be added to the ‘Master Category List’ of 
your Outlook. 
 

  

   

 
Once the projects with color codes are imported to your Outlook, when you tag an Outlook appointment or task item 
with a project, the corresponding color code would be applied automatically.  
 
This is very helpful to give a quick visual cognition as well as to organize your items in Outlook in a more obvious way. 
As this color code is deployed centrally, all members working on projects would have same uniform color coding for 
the entire team. 
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Screenshot below: Explorer view of calendar month in Outlook 2016 with appointments tagged with different 
projects and consequently the inherited color codes. 
 

 
 
Screenshot below: Inspector view of a particular appointment item in Outlook 2016 tagged with project and the 
inherited green color code. 
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Likewise, in Outlook task folder, the items tagged with projects appears color coded in small rectangle as seen in the 
screenshot below: 
 

 

Note: Color coding of 
tagged Outlook item 
requires that you enable 
‘Add Project to the 
Categories field of the 
item when tagged’ option 
(3). 
 

 

 

Add Project to the categories field of the item when tagged 
This allows for the tagged project value to be added to the categories field of the particular Outlook item. This option 
needs to be enabled if you want to enable color coding of tagged project items in Outlook. 
 
Tagged project value added to the categories field of the particular appointment item. 

 
 

 

Add Activity to the categories field of the item when tagged 
This allows for the tagged activity value (of a particular project) to be added to the categories field of the particular 
Outlook item. 
 
Tagged activity value added to the categories field of the particular appointment item. 
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The User Interface  

 

 

You have a choice where the timesheet toolbar should be placed in your Outlook main explorer window. By default, 
the timesheet toolbar is placed under Outlook predefined tabs such as ‘Home’ or ‘Appointment’. And that too, the 
first in the sequence of groups. 
 

 
You can change this option to place the timesheet toolbar in its dedicated tab, or to place in the last sequence of the 
groups. 
 

 

Similarly, when you open an appointment or task item in Outlook, you can choose the placement of the timesheet 
toolbar in the inspector window of the item. By default, the toolbar is placed under Outlook predefined 
‘Appointment’ tab and first in the sequence. You can change this to use a dedicated tab, or to place in the last 
sequence. 
 

 



 

 

P
ag

e1
7

 

7. Configuring Reporting Options  
Team TimeSheet Client > My Reporting Options 

 

 

Allow reporting of private task and appointment item 
By default, Outlook items that marked private are enabled for reporting, just like normal items. You can prevent 
private items from being reported by disabling (un-checking) this particular option. Preventing private items might 
be useful to separate personal outlook items from those used for project reporting.  
 

When reporting of private item is not 
enabled, when you try to report it, you 
would see a message box on why it can’t be 
reported successfully. 
 

  

 

Allow reporting of recurring task and appointment item 
By default, recurring items are enabled for reporting. You can prevent recurring items from being reported by 
disabling (un-checking) this particular option. This might be useful, if you don’t use recurring items for project 
reporting. 
 

When reporting of recurring item is not 
enabled, when you try to report it, you 
would see a message box on why it can’t be 
reported successfully. 
 

  

 Move reported items to subfolder 
If this is enabled, all reported items will be moved to a subfolder named ‘Reported tasks’ or ‘Reported 
Appointments’ (depending on the folder content type) under the parent folder. This subfolder will be created on 
every folder where reporting is performed. 
 
Reported Items from any Tasks folders are moved automatically to the corresponding ‘Reported Items’ subfolder. If 
this folder is not present (true if it is reporting for the first time on the parent folder), it will be created automatically. 
The same is true for reported appointment items in any calendar folders. 
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 Automatically report overdue items at startup 
If this is enabled, items that are overdue will be reported to the database automatically on Outlook startup.   
 
For Outlook task item, the due date is checked against the current date and if it occurred before that, it is reported 
automatically to the project database. 
 
For appointment item, the end time is checked against the current date/time and if it occurred before that, it is 
reported automatically to the project database. 
 
In both cases, if the overdue item is already reported, it is ignored. 
 
Note: 
This automatic reporting of overdue items is applicable to the default calendar and task folders only.  
 

 Automatically report task item when marked complete 
This option is only applicable to Outlook task item. If enabled, Team TimeSheet Client add-in would automatically 
report that particular task item when it is marked completed, provided, it has not been reported before (i.e., it does 
not yet have a report ID). 
 

 Automatically mark task item complete after successful reporting 
This option is also only applicable to Outlook task item. If enabled, Team TimeSheet Client add-in would 
automatically mark a reported task item as complete. 
 

 Ask me for confirmation before reporting to the database 
By default, when you report any Outlook task or appointment items, either one a time or in multiple mode, Team 
TimeSheet client does not ask for confirmation. You can change that by enabling this option. 
 

 
 
Asking for confirmation can be useful to avoid hasty or unintentional reporting of items. 
 

 Don’t allow multiple items reporting 
By default, you can select multiple Outlook task or appointment items and report at once, to the database in a single 
click. But you can change this behavior by enabling this particular option. Doing so, only the first selected item 
(among the selected items) will only be reported.  
 



 

 

P
ag

e1
9

 

 

Lock the Team TimeSheet fields of the reported item 
By default, the tagged fields of the reported item are enabled, which mean, you can edit and change the value even 
after successful reporting. But if you don’t have the need for editing or changing project related fields once it is 
reported, you can have it disabled to make it read-only. 
 
Screenshot: Locked state of the project and custom fields drop downs in the timesheet form

 
 

Default values for empty fields when reporting  

You can set a default value for each of the project field (including the custom drop down fields) such that when you report any 

Outlook task or appointment item, if one or more of the project fields including the custom fields are empty, Team TimeSheet 

add-in would automatically fill in the default value of the corresponding field to the particular Outlook item, before reporting it 

to the database. 

 

 

This automatic assignment of default values might be particularly useful if your administrator had marked project and other 

custom fields mandatory for reporting. 
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8. Preparing timesheets with Outlook appointments or task 

 
Once you have chosen your own list of projects and activities and other custom lists (if any), you will notice that under the 

calendar or task Outlook folder, the selected projects and activities are being populated as drop downs fields under the 

TimeSheet form in Outlook.  

 

To tag a selected appointment or task item, click the drop-down control of the project or any of the custom fields and specify a 

value from the list. When you select a project, the corresponding activities for that project will be loaded into the drop-down list 

of the activity control, thereby allowing you to specify a valid activity. 

 

  



 

 

P
ag

e2
1

 

8.1 Tagging Outlook items with project data 
 

Recording time is as simple as creating a calendar or task item and setting a few properties. You can use Team TimeSheet Client 

in Outlook to tag and report it to database. There are two modes of working with Outlook items – Explorer or Inspector.  

Explorer window mode  

You will find a side bar timesheet form in the Outlook calendar/task folder explorer and inspector window to show the 

project/activity, billable hours and all the custom fields defined by the manager. 

 

 

With this form, you can have quick access to the Project/Activity and other custom fields and any changes/editing on the fields 

are instantly saved to the appointment/task item. You don't even need to open the appointment item in its inspector window. 

However, if you use the inspector window to open the appointment/task item, the same form is available. 

 

Project drop down control – lists all the available projects that you have selected from the central database. 

 

Activity drop down control – lists all the available activities for the particular project selected. 

 

Billable Hours – is the time interval that will be used for billing or payroll purpose. It differs from duration of the 
appointment in that, duration is dictated by the actual interval of the Outlook appointment, whereas, Billable Hours 
is a user specific field that can be overridden to specify user’s own interval time. 
 
The 'Total Cost' of the published timesheet in the database is computed either by using the 'Duration' or the 
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'Billable Hours' value, depending on what the administrator had chosen in the manager add-in (i.e., under Advanced 
Options > Total Cost tab > For Calculating Total Cost, use). 
 
Note: 
When preparing a new timesheet in Outlook, by default, the Billable Hours field have the same value as the 
'Duration' field of the appointment/task item. 
 
The user can change the hours/minutes part of the Billable Hours from the timesheet form independent of the 
Duration field. 
 
If the administrator had chosen 'Duration' field for computing 'Total Cost' of the published timesheet, the 
administrator could hide the 'Billable Hours' field from appearing in the timesheet form. This is done from manager 
add-in (i.e., Advanced Options > Total Cost tab > For Calculating Total Cost, use) 
 

 

Custom Fields – are additional fields that are deployed by your administrator to collect further data on the project. 
A custom field can take the following data types: Text, Number, Currency, Yes/No, Date/Time, Note, List. If a 
custom field is marked red, it is mandatory to be filled before the appointment can be published to the central 
database. 
 

 

Publish Item – After finishing tagging project related 
data on the Outlook item(s), clicking this button 
would report to the project database. If the reporting 
was successful, the report ID that was generated in 
the database will be assigned to the particular 
Outlook item for reference. 
 

  

 

Create Copy - Create a clone of the current selected or opened appointment/task item with the same properties 
and along with the project/activity and custom fields data that might have been tagged previously. 
 
This could be handy if you have to submit multiple timesheets of the same properties and project. 
 

 Save – Save any changes made to the current timesheet form in Outlook, without closing the form or navigating 
away to another appointment. 
 
 

 Unlink – Remove and reset any references of published timesheet from the current Outlook appointment or task 
item. Once unlinked, the appointment or task item will be eligible to be published to the central database and 
would get a new timesheet ID.  
 

 

Withdraw – remove the published timesheet record entry that was published in the central database from the 
current Outlook appointment or task item. Once timesheet record is removed from database, the appointment or 
task item in Outlook will be unlinked and reset (by default). 
 

 

Delete – remove the current appointment or task item permanently from Outlook. 

 

All Project Fields – Clicking this button will pop-up a form that contains all the Team TimeSheet fields that are 
deployed by your administrator. This provides you a central place to manipulate the fields.  
 
Perhaps, the most important use of this form is the ability to replicate the same tagged values to all the selected 
Outlook items at once, something which, you can’t do with the timesheet form sidebar option. 
 

 

Views – This drop-down menu contains the 13 Team TimeSheet specific views as well as the normal Outlook views. 
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Inspector window mode 

When you open an Outlook task or appointment item, the inspector window pop-ups and it shows all the project information on 

that item under the timesheet form that is available at sidebar location of Outlook. 

 

 

The project fields, buttons etc. under the timesheet form of the inspector window remains the same as discussed previously in 

the Outlook explorer mode. 
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8.2 Group Tagging – Setting project data to multiple appointments/tasks 

 
Multiple items tagging (batch tagging) - if you select 2 or more appointment/task items in Outlook, you could make use of the 

'Group Tagging' button (available in the Team TimeSheet ribbon toolbar) to tag the same project or activity or billable hours or 

custom field value to all the selected appointment/task items in one go. 

 

  
 

And from the project fields, you can then set the common value for all the selected appointment/task items. 
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8.3 Tagging Recurring appointments 

 
There are some differences in the way you would tag recurring appointments from normal appointments. A recurring 

appointment automatically repeats at fixed intervals e.g. every Friday or the second Monday of every month. In Outlook, a 

recurring appointment consists of two portions – the parent series, and the individual occurrence. 

In recurring appointment, you can  

- tag the parent series item 

- tag individual occurrence item 

In table view, a recurring appointment is shown in series, which means, if you tag it with a project or custom field value, it would 

be applied to the parent series item. In table view, there is no way to open a recurring appointment in occurrence mode. 

Project and custom field values for the parent series item in table view 

 

However, in calendar (Day/Month/Year) view, a recurring appointment is shown by occurrence, i.e., an item for each 

occurrence. This means, if you tag an occurrence item with a project or custom field value, it would be applied to that particular 

occurrence only. In Calendar view, you can open it in both series and occurrence mode. When you double-click a recurring item, 

Outlook would automatically prompt you if you would want to open it in series or occurrence version. 

 

Team TimeSheet supports tagging individual occurrence item as well as the parent series item. Likewise, you can report both 

individual occurrence and the parent series item as well. Team TimeSheet will treat them as if they were multiple standard 

appointments. 

You can open the recurring appointment in series mode, to tag project and custom field values differently than those of 

individual occurrence item. 
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Project and custom field values for the parent series item 

 

 

Project and custom field values for the first occurrence 

 

 

If you have enabled project color coding of tagged Outlook items, the color code of the recurring appointment is applied across 

the series. So, if you tag a different project to individual occurrence (than that of the series item), it won’t overwrite the series 

color code. 
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8.4 Reporting and Publishing timesheets to SharePoint 

 
If you have finished preparing timesheet and other project deliverables in Outlook appointment or task items, you are all set to 

publish to SharePoint. Make sure you have network connectivity to SharePoint site and then simply click ‘Publish’ button in the 

‘Team TimeSheet’ Outlook toolbar or from the timesheet sidebar form.  

 

If the reporting was successful, you will notice that the ‘Publish’ button is no longer available, instead there are new buttons to 

update or withdraw the timesheet. 
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If you change the Outlook views to list view, you will notice that the Outlook item is being tagged with the ‘Report ID’ of the 

corresponding published timesheet ID in the database. 

 

This is how the published timesheet #15 looks like in the SharePoint. 

 
 

Notice that Outlook predefined fields and project fields are included in the timesheet. The total cost of the timesheet is also 

automatically calculated during the reporting process. 
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8.5 Updating and withdrawing reported timesheets 

 
Once you have reported project deliverables and timesheets via appointment or task items from Outlook to the SharePoint, 

often there might be requirement for amending some changes to the reported data over time. Or simply, you might need to 

withdraw the reported timesheet altogether from SharePoint. The availability of updating and withdrawing of published 

timesheet in Outlook depends on the administrative settings on the Team TimeSheet Manager tool. 

Updating reported data via Outlook 

You can update or modify published data directly from Outlook only if your administrator had enabled ‘Allow members to 

update reported timesheet’ option in the Team TimeSheet Manager > Reporting Options panel. 

 

Supposing, the above option is enabled, when you select a published item in explorer window or open in inspector window, you 

will see that there is a new button.  

For example, ‘Update Report #15’ as shown below in the screenshot. 

 

This way, you can change the project or custom field drop down values as well as update any other Outlook fields such as 

subject, location, mileage, body etc. and then re-submit again to update the existing report on the project database. 

Withdrawing reported data via Outlook 

Likewise, if your administrator had enabled ‘Allow members to withdraw reported timesheet’ option in the Team TimeSheet 

Manager > Reporting Options panel, you would be able to cancel a particular reported timesheet and withdraw it from the 

SharePoint via Outlook. 
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If withdrawal is allowed, once you have reported an 
Outlook item, a new button is available in the Team 
TimeSheet toolbar or in the sidebar timesheet 
form. For example, below in the screenshot, you 
can withdraw the submitted timesheet for this 
appointment by clicking the ‘Withdraw #15’ button. 

 
 

 

If withdrawal was successful, the reported timesheet is removed from SharePoint, and the particular Outlook item will be again 

available for reporting. Notice the update and withdraw buttons are substituted by the ‘Publish’ button. 
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9. Group publish – Publish multiple items to SharePoint 

 
Allows for showing all non-reported (non-
published) appointments/items of the 
current calendar/task folder based on 
specified timer period.  
 
Supports a filter search option. And then 
publish items in batch. 

 
 

 

 

The current calendar or task folder path in Outlook 

 

Time Period: Choose a time period from the followings under which the search will be confined: 
Today, Yesterday, This week, Last Week, This Month, Last Month, This Year, Last Year, Custom 
 

 

Further refine the search by using one of the following filter:  

 

 

The unpublished outlook appointment or task items that meet the search criteria. To publish to database, check the 
boxes and click ‘Publish’ 
 

 

Publish the checked items to the project database. 
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10. Review Published – Review appointment/task items that were published  

 
Run this tool to quickly review published 
appointment/task items of a particular 
calendar/task folder in Outlook.  
 
You can make changes if required before 
updating back to SharePoint, or if the project 
has been cancelled, you can withdraw the 
timesheets from SharePoint. 

 
 

 

 

The current calendar or task folder path in Outlook 

 

Time Period: Choose a time period from the followings under which the search will be confined: 
Today, Yesterday, This week, Last Week, This Month, Last Month, This Year, Last Year, Custom 
 

 

Further refine the search by using one of the following predefined filter:  
 

 
 

 

The published outlook appointment or task items that meet the searched criteria. To update, withdraw, unlink or delete 
the corresponding timesheet entries from SharePoint, check the boxes and click the appropriate button accordingly. 
 

 

Withdraw – remove the published timesheet record entry from the central database for the Outlook appointment or 
task items that are selected in the list (above). Once timesheet records are removed from SharePoint, the appointment 
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or task items in Outlook will be also unlinked and reset (by default) from the SharePoint record. 
 

 

Unlink – Remove and reset any references of SharePoint record from the Outlook appointment or task items that are 
selected in the list (above). Once unlinked, the appointment or task items will be eligible to be published to SharePoint 
again to get a new timesheet ID. 
 

 

Delete – remove the Outlook appointment or task items that are selected in the list (above) permanently from Outlook. 
 

 

Update – If you have made changes to the published appointment/task items, you can update the changes back to the 
timesheet records in SharePoint. 
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11. Work with Outlook Views 

 
Outlook views are a wonderful tool to automatically sort, quickly find information and rapidly re-arrange Outlook items in any 

folder. Views can also be organized to group and filter items to make a particular feature of your information obvious at first 

glance.  

Team TimeSheet provides 13 special Outlook 
views to help you to work with your projects 
and deliverables in a simpler and sensible 
way.  
 
These views can be accessed through the 
‘Views’ drop-down menu, available in the 
Team TimeSheet toolbar or ribbon.  
 
These views are common to both 
appointment and task items in your Outlook.  
 
 

 
 

Let us discuss some of the Team TimeSheet specific views. 

View 1 – Reported ID 

This a table view, where all the reported Outlook items are arranged by unique ‘Report ID’ field in ascending order. The Project 

and Activity fields are also available in the view. 
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View 2 – Reported State 

This is a table view, where all the Outlook items are grouped by the reported state i.e., if the item has been submitted to the 

project database. Reported items will be group under ‘Yes’ and unreported items under ‘No’ or ‘None’. You can easily 

differentiate reported items from the unique ID value.  

 

View 3 – Project and Activity 

This is a table view, where all the Outlook items are first grouped by project, and then sub-grouped by activity value. This gives 

you a hierarchy tree representation of all Outlook items and may prove useful to track and pinpoint a specific project or activity, 

or to get the number of items belonging to a specific project or activity, or simply just to have a listing that is better organized 

and summarized. 

 

Notice that, you can easily swap or change project or activity by dragging an item from one group or subgroup to another. 
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View 3 – Due Date 

This is a table view where the Outlook task items are grouped by the due date. 

 

View 4 – Items without Project (Filtered) 

This is a table view showing only those items that are not tagged with a project.  

 

View 5 – Calendar view of reported items (Filtered) 

This is a special calendar view showing only reported items in that particular task or calendar folder.  
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12. Searching TimeSheets in DB 
Team TimeSheet Client > Search my timeSheets in DB 

With the Search utility, you can run queries on your published timesheets. A variety of search parameters are predefined 

to help you find your published timesheets easily and quickly. You can also limit the search to your published timesheets 

only by choosing 'My TimeSheets' scope. 

 

 

Time Period: Choose a time period from the followings under which the search will be confined: 
Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This 
Year, Last Year, Date Range, On 
 
The option 'Date Range…' allows for user selection of start and end date. 

 
 

 

Report Type: Choose a report type from the predefined ones below: 
Any, TimeSheets Starting, TimeSheets Ending, TimeSheets Reported, TimeSheets Ongoing, TimeSheets Approved, 
TimeSheets Declined, TimeSheets Pending Approval, TimeSheets Completed, TimeSheets with Empty Project, 
TimeSheets with Empty Activity  
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Search By: Further refine the search by filtering through keywords or using one of the following timesheet 
fields: Project/Activity, Reported By, Duration, Billable Hours, Importance, Custom Lists. 
 

 

Group By: You can choose to group the timesheets either with:  
Project, Activity, Reported By, Importance, Categories 
 

 

Fields – you are free to choose which particular timesheet fields/columns that will show up in the search result and 
report. Just click the 'Fields' button, and choose the wanted columns to include.  
 
You can re-arrange the columns by drag-and-drop to get the kind of view you want. And the display order of the 
columns will be retained in subsequent sessions. The tool will remember your choice in subsequent runs. 

 
 

 

Detail Info button: Click this to view finer detail information of the selected timesheet (as available in the project 
database) in a new window. 
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Print: Click this to print the selected timesheets using the 'Print' template (as defined under Team TimeSheet 
Manager > Templates Manager). If you select a single timesheet to print, it will show you the print dialog 
option, where you can customize the layout, paper size etc. However, if you choose multiple timesheets, it 
will print directly using the default settings without displaying any ‘Print’ options. 
 

 

Export to PDF: Click this to export the selected timesheets to PDF document files. You can also export to Word 

Documents, HTML, plain text etc. 
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13. My TimeSheet Summary Reports 
Team TimeSheet Client > My TimeSheet Summary Reports 

 

With Summary Reports, you can get an on your submitted deliverables, timesheets and aggregate hours and expenses for the 

selected period. It comes handy to keep track of current budget deficit and work done, and plan and forecast requirements for 

resources and work hours for remaining part of the projects. Any user-defined and project specific fields can be chosen for 

inclusion into the reports. Aggregated and summarized reports can then be exported to PDF, Word, Excel, Text, XML or HTML 

web page or printed for sharing and easy distribution.  

There are four report view modes - List, HTML, HTML Editable and Grid. Noticed that this report tool also uses the same sets of 

search filters discussed in the last section. 

 
 

NOTE: You will be able to get timesheets overview for all members if your administrator had enabled the option ‘Allow members 

with admin-access to view Summary Reports on all reported timesheets (for all members)’ under Team TimeSheet Manager > 

Access Control. Otherwise, you will be able to only get overview for those timesheets that you had reported. 

 

Each timesheet in the search result is color coded to reflect the current state of the timesheet such as if it approved, decline or 

approval pending. Now, you can easily recognize which timesheets require the attention or review, and plan actions accordingly. 
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Time Period: Choose a time period from the followings under which the search will be confined: 
Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This Year, 
Last Year, Date Range, On 

 
 

 

Report Type: Choose a report type from the predefined ones below: 
Any, TimeSheets Starting, TimeSheets Ending, TimeSheets Reported, TimeSheets Ongoing, TimeSheets Approved, 
TimeSheets Declined, TimeSheets Pending Approval, TimeSheets Completed, TimeSheets with Empty Project, TimeSheets 
with Empty Activity  
 

 

Search By: Further refine the search by filtering through keywords or using one of the following timesheet fields: 
Project/Activity, Reported By, Duration, Billable Hours, Importance, Custom Lists. 
 

 

Group By: You can choose to group the timesheets either with:  
Project, Activity, Reported By, Importance, Categories. 
 

 

Fields: Click the ‘Fields’ option to choose which particular timesheet fields/columns will show up in the search result and 
report. 
 

 
  

The tool will remember your 
choice in subsequent runs. 
 
You can re-arrange the 
columns by drag-and-drop 
to get the kind of view you 
want. And the display order 
of the columns will be 
retained in subsequent 
sessions. 

 

 

Print the current report - When you click ‘Print’, you would be presented with the print dialog (similar to one used by 
Internet Explorer browser). Within that dialog, you would be able to customize the print settings. Note that, as there are 
multiple report modes (namely, list, HTML, Grid), the printed report will be sourced from the current mode (tab) that you 
are in. 
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Save the current report to file – Once you get the look and feel of your report, you can then export the report to one of 
the many popular document formats supported such as Microsoft Excel sheets, Word documents, Adobe PDF, Rich Text 
or web page etc. for sharing with others users, or for future reference. 
 

 
 

 

List report view mode – This acts like a template to the other three report modes. For finer control over the output of 
report, you can choose which fields (including custom fields) are to be included in the report. You can sort the timesheets 
by clicking at the column headers, as well as also re-arrange the columns in the list view according to certain sequence of 
your choice, and even set the width of the columns. These formatting from the List view panel will be inherited on other 
tabs - HTML, editable HTML and Grids.  
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HTML report view mode – This report view presents the timesheets in web HTML format with color coding, group, and 
summary information retained. You can export this report to .htm  or word (.docx) format for your further use. 
 

 
 

 

HTML Editable report view mode – This report view is exactly the same as the previous HTML mode, but with the 
flexibility to edit the HTML content in a WYSIWYG editor. For instance, you can customize the font, add image, change 
the color, layout or add any further information you require so that you can compile your own report. 
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The Grid report view mode – This presents the timesheets in excel spreadsheet like format with rows and columns, 
preserving color codes, summarized information etc. You can also re-edit and tweak the report. You can also copy data 
from this grid to Microsoft Excel or vice versa. And you can of course export the report as Excel spreadsheet file (in XLXS, 
XLS format). 
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14. My TimeSheet OLAP Statistics 
Team TimeSheet Client > My TimeSheet OLAP Statistics  

 

With the integrated Online Line Analytical Processing (OLAP) tool, you can analyze your submitted timesheets and other project 

deliverables in multidimensional view to extract critical information and intelligence. The tool supports the ability to explore 

large complex data sets and allows displaying in grids, charts and graphs and support most common operations such as pivoting, 

drill down/slice and dice, filtering etc.  

 

NOTE: You will be able to get run OLAP statistics on timesheets (even those published by others) if your administrator had 

enabled the option ‘Allow members with admin-access to view OLAP Statistics on all reported timesheets (for all members)’ 

under Team TimeSheet Manager > Access Control. Otherwise, you will be able to only see statistics for those timesheets that 

you had published only. 

14.1 The User Interface 

 

 

This statistical tool presents an easy-to-use interface for operating an OLAP-slice. The basic data is displayed in the working area. 

The environment tools for managing the content and characteristics of the slice are placed on the pivot panels. You can set the 

panels' layout the way you like. To drag a panel to a different location, you need to capture and drag its header with the mouse. 

This will highlight all the possible locations where it can be dropped. You can detach a panel from the component; it will be 

displayed as a float window.  
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Instrumental panels can be: 

• Attached to any side of the component;  

• Placed into any existing panel;  

• Displayed as bookmarks on any panel;  

• Set as auto-hidden panels;  

• Used as float windows. 

 

The File menu 
The file menu consists of the following commands: 

 
a) Open Offline Cube from file - While generating a live cube from the project/timesheet database 

provides the advantage of analyzing live data, often, you might be away or disconnected from the 
network. 
 
In such scenario, you have the option of connecting to an offline cube, which was previously generated 
and saved to your local folder using this utility. An offline cube file has the extension – ‘.offlinecube’ and 
can be either in compressed or uncompressed format. An offline cube gives the same functionality as 
that of a live cube (which is generated from the project/timesheet database at real time), except that 
the data in the offline cube is only current to the time the cube was saved to file. This provides the 
flexibility to continue analyzing the cube and writing reports etc., while you are on the move. 
 

b) Open a Predefined View - More than 30 views specifically designed for Team TimeSheet are included. 
Simply select a view and click ‘Load’ or double-click to load the statistical analysis of that report, the 
result will be displayed in the Grid or Chart (depending on the current active view). 
 

 
 

c) Open report view from file - Once a particular snapshot of the statistics is achieved, you may want to 
save it for future reference or share it among your team members. A report view is the current state of 
the statistics in the Grid/Chart working area, with specific member fields on the pivot panels (Rows and 
Column areas) and measure fields in the values area. It has a file extension ‘.olapreport’. 
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d) Save report view as - If you want to share a report view with others, you can simply save the current 
report (state of the statistics along with the pivot details) to a file folder of your choice - could be a 
network folder also. 
 

 
 

e) Save to offline Cube – Once you have loaded a live cube from the database, you have the option to 
save the entire cube data to a file (with the extension .offlinecube) for offline use, when you are 
disconnected from the network. Offline cube can be saved in compressed or uncompressed format, the 
former option will enable you to reduce the file size considerably. 
 

f) Same as e. (above) 
 

g) Close the cube - This option closes the cube from the OLAP Statistics and free up the memory for 
loading another cube. 

 
 



 

 

P
ag

e4
8

 

 

View Menu 
Contains actions that you can perform on the current report view. 

 
 

a) Reset Chart/Grid - Empty all the member fields from the pivot as well as the data from the working area of 
the chart/grid. This is useful if you want to start over on a new report view. 
 

b) Synchronize Chart/Grid - This option allows you to reflect the state of the statistics between Grid and chart. 
It is particularly useful, for example, when you have built up a grid with aggregated data, but with a more 
visual representation of the statistics in the form of graphs and bars. Also note that, the synchronization will 
be done to the other part (grid or chart) based on the current interface.  
 
For example, if you are in the grid view, and if you press ‘Synchronize Chart/Grid’ it would read the state of 
the Grid view and impart the same state (same members and measures) to the Chart view and vice versa. 
Each of the Grid and Chart views can be worked independently as long as you don’t press this synchronize 
option. 
 

 

OLAP Grid panel 
The OLAP Grid control comprises of a multi-dimensional table with expandable nodes. These nodes group and 
display data according to the hierarchies used to define the measures and dimensions upon which the underlying 
data has been organized. A unique feature of control allows for building the OLAP-reports of the exceptional level of 
complexity. In tandem with the OLAP Chart, the OLAP Grid provides an ideal means of clearly conveying data to the 
user. 
 

 

OLAP Chart panel 
While OLAP Grid allows working with numbers, the OLAP Chart allows representing the project data graphically. 
This gives managers and members a unique opportunity to analyze their project data visually, dealing with charts 
rather than numbers, which is much easier to perceive. 
 

 

Cube structure panel 
The panel contains the Cube structure - measures and hierarchies as a tree. The measures are grouped in the set, 
displayed in a branch. Rest of the tree nodes are the dimensions that contain hierarchies. 
 

 

 - Measure 

 - Dimension 

 - Attribute hierarchy 

 - Multilevel hierarchy 

 
To select a measure for display you need to drag-n-drop it to the 
Measures panel or the data area.  
 
To select a hierarchy for display – drag-n-drop it to the hierarchy area 
or the pivot panel (rows or columns area). 
 

• Measures are grouped in the Measures category. 

• Hierarchies are sorted into folders - dimensions. If there's 
only one dimension in a hierarchy, it will be displayed in the 
tree root. 
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Both hierarchies and measures have their own menus. Right click will call the context menu that gives you an option 
to place the element where you like. You can also filter the selected element (see Filtering hierarchies and 
measures) or place it to the selected panel. 
 

 

Pivoting panels 
A pivot table lets user design the report online by dragging and dropping measures, dimensions and levels into the 
pivoting panels. Note that the column panel may contain no more than one (!) measure. Panel elements can be 
dragged with the mouse to other panels. To filter elements, press the Filter button (see Pivot panel view) or use the 
appropriate items from the context menu. 
 

 
 

 

Measure panel 
Measure panel consists of groups of measures that make up the charts' vertical axes (see Measure panel 
components). Each group of measures corresponds to a set of charts in the data area. Groups of measures are 
situated in the main part of the panel. 
 

 
 
You can drag measures from one group to another, or extract measures from groups to delete them. To create a 
new group, you need to drag a measure to a place on the panel not occupied by another group or to the <drop an 
item to create a new group> panel. 
 



 

 

P
ag

e5
0

 

Clicking a mouse button on measures will call the context menu. From here, you can move a measure to one of the 
pivot panels or to the modifiers axis, or assign a measure filter. Also, you can assign the marker type of a chart point 
and its color. 
 

 

Filter panel 
This statistical tool allows for easy selection on what data you want to see and what you don’t. You can apply 
powerful filters to anything including hierarchy members, and measure values, thus leaving out the unimportant 
data. You can sort the data to see, for example, the top 10 values and then you can gather the rest of the values 
into a single group, so you only have what you really need. 

The filtered elements (hierarchies and 
measures) are automatically transferred to 
the Filter panel. To assign a filter, you have to 
move an element to the Filter panel. If the 
element hasn't been filtered the appropriate 
visual filter editor will be shown, similar to 
the one on the right: 
 

 
 
 In the Filter panel, you can call the Filtered Element Editor individually for each element.  

 
 
 

 

Working Area 
The OLAP-slice data is displayed in working area. In its upper part there is a menu for the quick access to the 
frequently used commands². The rest is occupied by the current OLAP-slice and consists of the following parts - 
Cube Axis headers, Cube Axes, Data Axes, Data Axis headers, Chart Panes. 
 
You can change the view of the slice by relocating measures and hierarchies within the environment panel. When 
you start dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most 
elements have context menus that duplicate the mouse actions and provide additional control functions for 
managing the slices' view. 
 
 
 
 
 
 
 
 
 
Grid working area 
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Chart working area 
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14.2 Working with OLAP Grid 
 

The OLAP Grid view comprises of a multi-dimensional table with expandable nodes. These nodes group and display data 

according to the hierarchies used to define the measures and dimensions upon which the underlying data has been organized. In 

tandem with the OLAP Chart view, the OLAP Grid view provides an ideal means of clearly conveying data to the user. It is highly 

navigable and quickly provides detailed information to the user. The speed with which data recall occurs and the strong 

formatting the grid enforces ensure data is always presentable and easily understandable. Consequently, OLAP Grid views can 

easily be ported to spreadsheet applications for report compilation purposes.  

Additionally, the OLAP Grid view allows users to effortlessly add and remove categories, filter and sort categories, and drill up or 

drill down on data using powerful built-in menus. One of its greatest benefits is that it allows users to explore, navigate and 

refine data until the desired snapshot is achieved. Once in place this snapshot can be reflected in a complementary chart. This is 

possible as OLAP operations in Grid view can be synchronized with Chart view. These two data views can then be deployed side-

by-side or on top of one another. 

 Unicode support.  
 Simultaneous display of several different measures in the Grid.  
 Simultaneous drilling down based on different parameters: up to the nearest child, up to the next level, up to the next 

hierarchy.  
 Saving and restoring the current OLAP-slice.  
 Hierarchy members grouping (including multilevel and parent-child hierarchies).  
 Separate sorting on different hierarchy levels. Possibility to override any sorting method.  
 Ascending or descending sorting based on the cell values in any column of the Grid.  
 Filtering of hierarchy members with or without applying these filters to the OLAP calculations.  
 Auto filtering of the hierarchy members depending on their values in the Grid. Major/minor members selection, either 

based on their rank or on the Pareto principle.  
 Replacing hierarchy members by drag-n-dropping them within the Grid.  
 Auto sizing of cells depending on their contents.  
 Flexible export to MS Excel, HTML, GIF, JPG, PNG, BMP, CSV, TXT, PDF formats. 

 

Operating the OLAP-slice 

The OLAP-slice data are displayed in a table, whose appearance may be amended to some extent. For operating the current 

OLAP-slice there are the following functions available: 

1. Navigation 
2. Selecting and copying data 
3. Drilling, sorting and moving hierarchy members 
4. Operating context menus 
5. Filtering data 
6. Editing data 
7. Setting the column width 

1. Navigation - You can easily navigate the data using the keyboard: 

Button Action 

Home Move to the first cell of the row 
End Move to the last cell of the row 
PageUp Move one page up 
PageDown Move one page down 
Ctrl+Home Move to the top left cell 
Ctlr+End Move to the bottom right cell 

 

Using the mouse, you can scroll the table up and down. 

Mouse Action Component Action 

Scrolling the mouse wheel Vertical scrolling of the table 
Scrolling the mouse wheel with the Shift button held down Horizontal scrolling of the table 
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2. Selecting and copying data - The data area in the component can be selected like everything else in Windows: 

• Select all the cells pressing Ctrl+A;  
• Capture the area with the mouse;  
• Change the boundaries of the selected area with direction buttons, holding down the Shift button.  

You can copy the data from the selected area to the clipboard by pressing Ctrl+C. If there’s no selection, pressing these buttons 
will copy the whole OLAP-slice to the clipboard. 
 

3. Drilling, sorting and moving hierarchy members - 
To perform the drilling of the hierarchy members 
press buttons on the Grid cells. If there’s only one 
drilling button in a cell, then, instead of pressing it, 
you can double-click the cell itself. By default, the 
drilling buttons are shown only in the cells under 
mouse. To see all the buttons, press the Ctrl button. 
The last cells in the column area of the hierarchy 
members allow showing the sorting direction. A 
pointer that indicates the descending order of data 
illustrates it. You can manage the sorting modes by 
single clicking on the cells of the specified area: they 
are changed cyclically [descending sorting] -> 
[ascending sorting] -> [no sorting]. 

 

 

4. Operating context menus -The context menu, 
called by right clicking a table cell, partly duplicates 
the OLAP-slice control functions. 

 

 

 

 

 

Hierarchy levels' menu 
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The view of context menu of the hierarchy levels' area. There is a list of commands available in the context menu of the 
hierarchy levels’ area: 

Command Function 

Show totals first Show the aggregated cells before all the rest 
Show totals last Show the aggregated cells after all the rest 
Don’t show totals Do not show the aggregated cells 
Default sorting Range hierarchy members by default 
Sort ascending Range the hierarchy members by values from the bottom to the top 
Sort descending Range the hierarchy members by values from the top to the bottom 
Aggregate all hierarchy members Aggregate all the hierarchy members (including hidden) 
Aggregate visible members only Aggregate the visible hierarchy members only 
Drill all down\ to the next hierarchy Drill all down to the next hierarchy 
Drill all down\ to the next level Drill all down to the next level 
Drill all down\ to the same-level 
children 

Drill all down to the same-level children 

Drill all up Collapse all the elements of this level 
Clear filter Remove any applied filters 
Filter on captions Set the filter for measures 
Show empty cells Show the cells with no aggregated values 
Create new group … Create a new group. It will appear at the first level of the hierarchy 
Copy selection Copy the selected area to clipboard 
Conditional formatting Show the Conditional formatting menu 

 

Hierarchy members' menu 

 
The view of the context menu of the hierarchy members' area 

Command Function 

Drill down to the next hierarchy Open the node up to the next hierarchy in the current area, ignoring all the 
lower levels of the current hierarchy 

Hide this member Hide the member 
Hide all members except this Hide all the members of the hierarchy, except the selected one 
Hide all members above this Hide all the members of the hierarchy above the selected one 
Hide all members below this Hide all the members of the hierarchy below the selected one 
Show only the top Show the top elements of the level. Their number is specified in the sub-

menu. If you specify a percent value there, then the picking of members will 
be such that their total value does not exceed the one, specified in the sub-
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menu. 
You can choose a threshold value from those offered in the appropriate 
menu item or set your own one, selecting Other from the menu. 

Show only the bottom Show the bottom elements of the level. Their number is specified in the sub-
menu. If you specify a percent value there, then the picking of members will 
be such that their total value does not exceed the one, specified in the sub-
menu. 
You can choose a threshold value from those offered in the appropriate 
menu item or set your own one, selecting Other from the menu. 

Filter on captions Set the filter for measures 
Create new group.. Create a new group on the current level 
Copy selection Copy the selected area to clipboard 
Conditional formatting Show the Conditional formatting menu 

 

The menu for groups of hierarchy members 

 
The context menu that appears above the group cell. 

 

Command Function 

Hide this member Hide the selected member 
Hide all members except this Hide all the hierarchy members except the selected one 
Hide all members above this Hide all the hierarchy members above the selected one 
Hide all members below this Hide all the hierarchy members below the selected one 
Show only the top Show the top elements of the level. Their number is specified in 

the sub-menu. If you specify a percent value there, then the picking 
of members will be such that their total value does not exceed the 
one, specified in the sub-menu. 
You can choose a threshold value from those offered in the 
appropriate menu item or set your own one, selecting Other from 
the menu. 

Show only the bottom Show the bottom elements of the level. Their number is specified 
in the sub-menu. If you specify a percent value there, then the 
picking of members will be such that their total value does not 
exceed the one, specified in the sub-menu. 
You can choose a threshold value from those offered in the 
appropriate menu item or set your own one, selecting Other from 
the menu. 

Filter on captions Set the filter for measures 
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Create new group Create a new group 
Delete this group Delete the selected group 
Clear this group Clear the selected group 
Rename this group Rename the selected group 
Copy selection Copy the selected area to clipboard 
Conditional formatting Show conditional formatting menu 

 

 

Measure values' menu 

 

 The context menu that appears above the group cell: 

Command Function 

Sort ascending  Range the cells in the column by values from the bottom to 
the top  

Sort descending  Range the cells in the column by values from the top to the 
bottom  

No sorting  Remove any sorting  
Filter on captions  Set the filter for measures 
Hide these measures Hide the selected measure 
Show as Specify the display mode of the current measure in the 

Grid: 
default 
percent aggregated value in the row 
percent parent element of the row 
percent parent element of the column 
percent total aggregated value 

Copy selection Copy the selected area to clipboard 
Conditional formatting Show conditional formatting menu 
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5. Filtering data - The filtered elements (hierarchies or measures) are automatically placed on the filters' panel. To start filtering, 
move the element to the filters' panel. In case the element has not been filtered, the appropriate editor will launch (the 
Hierarchy Editor for hierarchies and the Measure Filter Editor for measures). In the filters' panel, you can launch an editor for 
each element independently. 
 

The buttons for launching the editor ( ) are placed on the 
panels in the Hierarchy levels’ area. If the button looks like 
this ( ), it means the hierarchy had hidden members inside. 
Pressing the button starts the Hierarchy editor. 

 

 
 
6. Setting the columns' width - You can change the width of columns in the data display area by dragging the right boundary 
with the mouse. If possible, these changes will be saved during other operations with the table (like drilling, sorting, etc.) To 
return to the original width, double click the right boundary of the column where it is visible. In case there were such changes in 
the table that saving the assigned width of the columns was impossible (for example, if as a result of the Collapse drilling, the 
column with the assigned width has disappeared), it will be set automatically. Unfortunately, if you operate a big table, 
calculating the columns’ width takes up too much time. That is why if there are more than 10, 000 cells in your table, their width 
will be set to default, but it can be corrected later. 
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14.3 Working with OLAP Chart 
 

While the Grid view allows working with numbers, chart view allows representing submitted project data graphically. This gives 

you and other managers a unique opportunity to analyze reported data visually, as dealing with charts rather than numbers, is 

much easier. Now it’s easier than ever to spot new trends and discover unknown problems in your data flow. The statistical tool 

will help you gain an insight into your data and make new discoveries. 

 

Tools panel 
This panel houses all the frequently used operations on the OLAP chart - save, export, print and display options. 

Button Function 

 Load the Grid state 

 Save the Grid state 

 Export OLAP-slice data 

 Print OLAP-slice data 

 Preview 

 Undo 

 Redo 

 Switch axes 

 Select the docking panels layout 

 Set the scale of Chart display 

 Select the color palette for measures 
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Modifier panel 
Modificators are easy and powerful means of data representation. You can choose your data be shown in different colors, using 
different shapes and sizes, so that you can easy distinguish them in a single graph. You can simply place a dimension or a 
measure on a modificator’s pane and get the graph showing different values in a different manner. 
 
For example, you might place the "Problem Category" dimension on Color pane and get the Chart showing problem categories in 
different colors. Or you can place the "Cost" measure on Color pane to highlight the top rates of supporting the service requests. 
The same can be done for Shape and Size so that you can make your data perfectly distinguished. 
 

 

The layout of panels and hierarchies on the Modifier panel allows you to change the appearance of the displayed slice. When an 
element is placed to the modifier panel (except for Details), its legend will contain the display parameters. If you modify the 
color and shape of an element, the appropriate parameters can be amended. 
 

Modifier The changes made upon placing a Chart element to the modifier area of... 

a measure a hierarchy 
 
  

The color of the Chart elements will be chosen 
from the standard set of gradient colors  
 

Hierarchy members will be painted with the 
colors from the current palette 

Color The elements with the minimal value will be 
painted with the first of the gradient colors, 
and the elements with the maximal value - 
with the last one 
 

N/A 

Size Depending on the value of the measure the 
size of the Chart points will vary from the 
minimal to the maximal. 
 

Hierarchy members will differ in size 

Shape Forbidden Hierarchy members will differ in shape. If the 
number of hierarchy members will exceed the 
number of available shapes, some of them will 
be used more than once 

Details Forbidden The panels will display series for all hierarchy 
members 

 
If a measure is placed on the Color pane, its values range is mapped to the given colors range so that it’s tremendously easy to 
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spot the top/low values. If you select the discrete gradient type, you'll be able to set threshold values for filling the Chart 
elements. While the continuous gradient will let you evaluate the trend as a whole. To select the gradient type and tune its 
content, turn to the legend panel. 
 

The Legend panel 
The panel contains descriptions of the modified elements. 
The value, shape and color of a legend element can be 
edited. 

Setting the Color legend 
To select a color, simply double-click the appropriate 
element and choose a color from the pop-up editor. 

 

 

Setting the Gradient legend 
To edit the gradient, double-click the element and tune the settings in the 
editor. In the Gradient Editor there are: 

• a set of pre-made gradients;  
• selecting gradient option (continuous or discrete);  
• creating a gradient with a set number of intermediate colors option;  
• setting threshold in per cent and measure values option;  

 

Selecting threshold color option. 
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Setting the Shape legend 
The shape selection is made through the context menu. 
This option is available only for points or lines Charts. If 
the number of hierarchy members exceeds the number of 
available shapes, they will be repeated. 

 

Chart Panes 
The bulk of the OLAP-slice data are placed into cells with Charts. Each measure group has its own set of panes.  
 

 
Measure groups with corresponding Charts in the working area 
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Chart Type 

In the upper left part of each Chart, there will appear a 
context menu for selecting its type. There are six (6) charts 
that you can use, namely, Point Chart, Histogram, Point 
Shape Selection, Lines, Curved lines and Step lines. By default, 
the Histogram is used. 

 

The size of Charts can be changed to some extent. To expand 
a Chart along either one of the axes, you need to capture its 
boundary with the mouse and drag it. You can change the 
size along both axes (and return to default) through the tool 
menu in the upper part of the working area. 

 
Chart type menu 

 
  

Hot keys for changing the scale 

Ctrl+* Reset Scale to 1:1 
Ctrl+Num+ Zoom In 
Ctrl+Num- Zoom Out 

 

Navigation 
If the content of the Grid exceeds the client area, the scroll bars will appear. You can scroll down the data using the mouse 
wheel. To scroll the Grid in the vertical direction, turn the mouse wheel, while holding Shift. 

 

Selecting Data 

You can select Chart points with the standard Windows' method. Holding down the Ctrl button, you can add selected points, 

holding down the Shift button, you can select the horizontal range. You can filter the Grid's points while selecting. In that case, 

the corresponding hierarchy members will be filtered automatically. 

Selecting and filtering parts of Charts 

a. Selecting some of the Chart points 

 

b. Selecting the Filter command 
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c. The result 

 

Note: When moving the mouse cursor over a data axis, you are able to select a continuous range of members (if the axis is 
composed of them) or a range of values in Charts. 

 

Filtering hierarchies 

In case you need to collect data not from the whole Grid, but just from a part of it, the component has a few functions at your 

disposal: they let you select or remove elements from the slice. Also, there is a standard option of exporting data into a number 

of formats and printing out the content of OLAP-slices. The simplest way of selecting data is through the context menu. When 

you click a hierarchy member on the Cube axis, there is a set of commands for quick operations with members: 

• Hide this member  
• Hide all members except this  
• Hide all members above this  
• Hide all members below this  

Filter on hierarchy level 
The Filter area of the Editor becomes visible only in case if filtering by hierarchy levels is available. To apply a filter to hierarchy 
members, you need to select a hierarchy level (if there's more than one) and assign the Filter condition in the Filter menu. In the 
same menu, there's a command to clear filter. 
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Filtering hierarchy members 
If the search field is not empty, the "Find" command will make the component perform a search for hierarchy members, whose 
levels contain the specified string. You can narrow the search results by checking the "Exact matching" box.  
 

Filtering a single member of a hierarchy 
By default, the Editor is able to select any number of hierarchy members. To switch to the single-select mode, uncheck the 
"Multiselect" box. In that case, only one the hierarchy member with all its parents and members will be selected.  
 

 
  

Filtering measures 

There is a number of available parameters for filtering measures. In the same Editor, you can clear the filter. 
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14.4 Printing, exporting statistical data and charts 
 

Now that you have successfully designed a report, you might want to save it for future reference or share it with others. Reuse 

your work! You can now save data snapshots to HTML, BMP, CSV, GIF, HTML, JPEG, PDF, PNG, TIFF, TXT, XLS and XML as a simple 

way of reusing your data for documents and spreadsheets. Depending on the active view (Grid or Chat), the saved file would 

either take the grid data or the chart. 

 
Available export formats in Chart View 

 
Available export formats in Grid View 

Printing - You can print your report to share it with others using the built-in Print Preview window. You can tune your 
page/printer settings before printing. Also, if you feel like sharing the report through the net or by email you can easy export it 
to a wide range of formats including PDF, XLS, CSV, JPG, etc. 
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Export Settings -This tool allows you to customize the appearance of the reports to be printed or saved to a file format. You can 
specify the page size, orientation, headers & footers and color of the fonts and page background. 
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15. Uninstalling Team TimeSheet Client  

 
To uninstall the Team TimeSheet Client Tool from your computer, follow the steps outlined below: 

Step 1: Go to ‘Control Panel > Programs and Features’.  Scroll down to select ‘Team TimeSheet Client SP (x86) or (x64)’ and click 

‘Uninstall’ as illustrated below: 

 

Step 2: A dialog confirmation follows asking for confirmation. Click Yes.  

 
 

Step 3: The Team TimeSheet setup will now start the un-installation process. Make sure that Microsoft Outlook is not running 

(even under the task manager).  
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16. Important Links 

 
Team TimeSheet for Outlook & SharePoint – Home Page 

Go to the official website of Team TimeSheet for Outlook & SharePoint.  

  

Video Tutorial clips  

Watch video tutorials that teach you how to install, configure and work with Team TimeSheet.   

   

Purchase License  

Purchase an enterprise team license for Team TimeSheet for Outlook & SharePoint.   

    

Support Maintenance contract  

At AssistMyTeam, we're committed to give you the best support for all the products that we offer and more! The 

AssistMyteam Support Contract helps you use our products more efficiently and work out any issues that you 

encounter during the course of their use.   

   

Submit an online support ticket  

Use this web form to create a ticket with AssistMyTeam Technical Support.   

  

https://www.assistmyteam.com/timesheet-addins/
https://www.assistmyteam.com/timesheet-addins/video-tutorials/
http://www.assistmyteam.net/TeamTimeSheet/TutorialClips.asp
https://www.assistmyteam.com/timesheet-addins/purchase/
https://www.assistmyteam.com/support/
http://www.assistmyteam.net/support/
https://www.assistmyteam.com/support/submit-ticket/
http://www.assistmyteam.net/support/submitTicket.asp
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